Librarian 4.0 Update

Patch Factory™ Random Patch Generation

Library sampler

Shuffle

Shades

Patch Factory brings a new random patch generation capability to the Opcode Patch
Librarian. As a part of the Patch Librarian itself, it is available to all of the
synthesizers supported by the Librarian. There are currently four Patch Factory
"algorithms" but it has been carefully designed so that we can easily bring you more
of them in the future.

All of the current Patch Factory algorithms require some form of "inspiration”. This
can be any bank or library file you already have. While a file with an ordinary
assortment of sounds will produce quite random results, if you have a file of string
sounds, the results of randomization may (but may not) sound like strings. If you
use a completely new bank, you are not likely to get anything but "INIT VOICE".

To use Patch Factory, make your "inspiration” the active window by clicking on it.
Two of the algorithms require that you select two patches in the window — if you
select more, the first two selected will be used. Then, in the Factory menu, choose
the desired algorithm. The Factory algorithm will create a new window's worth of’
sounds. You can choose between having it create a bank, or a library with any
number of patches. You can then listen to the sounds, rename them to something
more descriptive (the names are randomly generated too), save them, or just throw
them away. With the DX, CZ, and FB, you can edit them to take the harsh edge off
them, or to add a harsh edge on.

Here are the algorithms provided and a brief description:

The Library Sampler is actually not a patch generator — it is a random patch
selector. It is useful for getting a quick randomly selected bank out of that 4000-
patch library you have. It doesn't even check for duplicates.

Shuffle is the primary random-generation algorithm in Patch Factory — it works
with all synthesizers in the Librarian series. It operates very simply — each byte in
each randomly generated patch is taken from the same byte in one of the inspiration's
patches, selected at random. For example, suppose Shuffle generates a bank of
random patches, and one of them is called Nawokip. The first byte of Nawokip will be
the same as the first byte of one of the patches in the inspiration, the second byte of
Nawokip will be the same as the second byte of some other inspiration patch, etc.
This may result in a patch which has some inconsistencies on a particular
synthesizer, but it does provide amazingly good results overall.

The Shades algorithm is designed to produce a gradual transition from one patch to
another. It requires that you select the two endpoint patches in the "inspiration”
window. Every parameter on the synthesizers (except parameters like "transpose™)
will be smoothly varied from one patch to the other. A special case is made for the
DX7 algorithm parameter — the first patch's algorithm is used for the first half of
the new voices, and the second patch's algorithm is used for the second half. Even
the names of the result will go from the first name gradually to the second one. The
Shades algorithm is initially only available for the DX7 family and the FB-01. It will




be disabled in the Factory menu if any other type of file is selected. We will be
giving more synthesizers the Shade Two capability in the coming months.

Constrained Random

The Constrained Random algorithm lets you control, on a parameter by parameter
basis, the limits of random generation. Like Shades, it requires that you select two
patches in the "inspiration” window. The parameter values of those two patches will
be used as the upper and lower limits of each parameter in the randomly generated
patches. This lets you allow Patch Factory to generate envelopes, but to leave
oscillator parameters alone, or vice versa, or anything else remotely similar. You
can use the Patch Editor to generate the two inspiration patches, setting the upper and
lower limits that way.

MouseKeys Channel Controls and Keyboard

There are four possible ways to play your synthesizer(s) from the Patch Librarian:

+ from the Macintosh keyboard, when Testing Sounds in the Edit menu is
checked

+ from your MIDI keyboard, when Echo Keyboard in the Record/Play
menu is enabled _

+ using Play Sequence in the Record/Play menu

+ using the MouseKeys

Normally, it will play through the topmost window's channel. But you can now
choose MouseKeys from the Record/Play menu to get a window with a
keyboard you can play with the mouse, and a set of controls to direct playing to any
channel you like. This is particularly useful for working with MIDI effects and
mixers and multitimbral (i.e. able to play more than one sound at a time)
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Channel controls / Automatic channel selection

The shaded box labeled "Auto", when shaded, enables automatic setting of the
channels and port that playing happens on. The channel and port will always match
those of the topmost bank or library window. This is the way that playing always
happened in earlier versions of the Librarian, and is still the default mode.

If you are working with layered sounds in an FB-01 or an ESQ1, or if you are using
a librarian for a nonsynthesizer like the PCM-70 or MPX820, you may want playing
to occur on several channels, or a different channel than the one the Librarian uses to
send patch information. You can now do this — select the channels that you want
playing to happen on by clicking on the little channel numbers. You can enable
multiple adjacent channels by dragging the mouse. Now playing will happen
simultaneously on all of the selected channels, or not at all, if none are
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selected.Selecting channel numbers this way (or clicking on the shaded "Auto" box)
will turn off automatic channel selection, causing the "Auto" box to become
unshaded. The selected channel and port will no longer change when new windows
become topmost.

Note for TX816 users:

Port selection

Multi

When automatic channel selection is on, the playback channels for TX816 windows
depend on the settings of the Whole Rack option and/or what patch(es) are
selected. If Whole Rack is on, the channels for all of the modules will be used.
Otherwise, the channel for the module containing the currently selected patch will be
used.

If you have MIDI interfaces connected to both the modem and printer ports of your
Macintosh, and your MIDI Setup is set accordingly, you can change the port that
playing happens on by clicking on the picture of the modem or printer.

The "Muld" shaded box, when enabled, means "Echo the keyboard and play
sequences using the same channel(s) that my keyboard is transmitting on." This is
useful if you would like to use a master keyboard to transmit on multiple channels to
multiple synthesizers (or even just one multitimbral synth). The setting of this
option doesn't affect Mac or MouseKey keyboard playing, but for keyboard echo
and sequences, it will take priority over automatic channel selection or the set of
channels you may have selected.

MouseKeys keyboard

Octaves

Key Velocity

Notes are played when you click the mouse on them, and released when you let go.
Dragging the mouse after clicking on a note will play the notes under the cursor,
monophonically.

The octave numbers for all of the C's on the keyboard are displayed on the keys.
You can transpose the keyboard up or down in increments of an octave by clicking
on the dark grey rectangles with arrows on them at the ends of the keyboard.

The MouseKeys are, believe it or not, "touch-sensitive”. Although the Macintosh
has no way of knowing how firmly you click the mouse button, you can generate
different amounts of key velocity by clicking in different parts of the key. To
experiment with this, first make sure you're using a synthesizer that recognizes key
velocity, and a sound with a fair amount of key velocity sensitivity programmed in,
perhaps a piano type of sound (probably not an organ). You'll notice that the higher
up you click on a note, the more softly it plays (less leverage on the key). For
consistency, both the white notes and black notes will generate an identical range of
velocity from their tops to the bottoms of the black notes. The portions of the white
notes below the bottoms of the black notes will generate the same velocity as the
bottoms of the black notes.




Key Velocity (KV) Range

LazyKeys

Repeat

The shaded bar in the middle of the area above the keyboard controls the range of
key velocity values playable by the MouseKeys. To change the range of possible
key velocities, click at the high or low end of the range, then drag the grey area to the
other end of the range. If you want to confine the range to a specific value, just click
anywhere on the bar and don't drag the mouse.

Click on this button to make it unnecessary to click the mouse to play the
MouseKeys. The button will become highlighted to indicate that LazyKeys is active.
New notes will play every time the mouse is moved over a different note than the
one being played. Notes will sustain until you click the mouse on the note being
played; clicking the mouse once again on that note will play the note. Sustained
notes will also be cut off if you move the mouse over some part of the MouseKeys
window other than the keyboard. Click on the button again to disable LazyKeys.

Not many synthesizers still have this as a front panel control, but the MouseKeys
do. While Repeat is on, the MouseKey most recently played will be played
repeatedly at a rate between 0.5 and 60 Hz, which correspond to settings of 0 to 120
on the Repeat Rate control to the right of the Repeat button.

Sustain Pedal You can play chords with the MouseKeys by using the Option key as a Sustain

pedal.

Moving and Getting Rid of the MouseKeys

In a slight bending of Apple's user interface guidelines for the Macintosh, the
MouseKeys don't become the topmost window when you click in them. This makes
it easy to play notes and select patches from banks and libraries without waiting for
the redrawing that happens when a window comes from behind another to the top.

However, to move or get rid of the MouseKeys, they need to be highlighted (having
horizontal lines next to the title) first. Click somewhere in the region around the
word "MouseKeys" and the window becomes topmost and highlighted. You can
hold the mouse down and drag it at this point.

Once the MouseKeys are highlighted, you'll see a go-away box in their upper-left
corner; clicking here will make them disappear.

Omni Mode for Multichannel Play

If you are playing through more than one channel, you can choose between two
different strategies for the Librarian to use in sending out the information. One
strategy is simply to send every MIDI event on every channel selected. The other
strategy is to put the selected channels in Omni mode, and to send the information
once on the lowest-numbered channel. To use Omni mode, check Omni Mode for
Muitichannel Play in the Record/Play menu.

Not using Omni mode will work in all cases with all synthesizers, but any
continuous information such as aftertouch, pitch bend, modulation, etc., will be
very slowed down. Using Omni mode may only work with certain synthesizers, but
all events will only be transmitted once, and therefore their timing will not be
distorted. Omni mode is definitely recommended for TX816 users.




Omni rnode_is not used when_ Mult is selected, because Multi mode cannot work if
any synthesizer is set to Omni mode.

Opening a Bank or Library window

Two changes have been made which streamline using the program. First, the

obnoxious message that tells you how to set up your synthesizer so that it is ready to

deal with patch information is now optional. You can prevent its automatically

appearing the first time you open a window by checking No Help in the File

ﬁenu. If things are not working correctly, you can read it at any time by choosing
elp....

When you select Open in the File menu, there is a new window which combines
the list of synthesizer file types with the list of files, which in many cases will save
you a keystroke or mouse click. Also, you can interactively try different file types,
instantly seeing the list of files of that type in the selected folder.

Duplicate patches and names in libraries

It is now a little easier to deal with duplicate patches in libraries, and duplicate
names. First of all, when you paste a patch into a library which is the same as one
of the patches already there, you will be shown the name of the patch you are pasting
along with the name of the patch (or patches!) already there. You can listen to the -
patch to make it easier to decide which of the names you want to use for that patch.

There is a new command, Delete Duplicates, which compares every patch in a
library to every other. Whenever duplicates are found, all names used by that patch
are displayed, and you are given the opportunity to listen to the patch and choose
your favorite name for that sound.

When you paste 2 non-duplicate patch with the same name as a patch already in the
library, you are given a window similar to the one in previous versions, but which is
easier to understand. Also, you can type a new name and just hit Return to try the
new name. (In the previous version, Return would replace the older patch with the
newer one),

Sticky options

Most of the checkmark items in the menus are now remembered by the program as
long as the disk it is on is not write-protected. These include: No Help in the File
menu; the choice between Enter Names and Testing Sounds, and No
Duplicates in Lib in the Edit menu; Echo Keyboard and Play on Select in
the Record/Play menu. Also, the port for each synthesizer is remembered in
addition to the channel, so that if your DX7 is on the Modem port and your CZ is on
the Printer port, the program will remember this.




Transfer

You can now go directly from the Librarian to any other program of your choice,
such as Sequencer 2.5, without going to the Finder. To do this, use the
Transfer... command in the File menu, and then pick the desired program.

Starting from the Finder

You can now select up to eight patch bank or library files in the Finder, either by
dragging a rectangle around them, or by shift-clicking on them. Then, you can
double-click on any one of them. This will start up the Patch Librarian with all of
the selected patch files open.




